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In This lecture  

 
● Starting AutoCAD 

● Dealing with the AutoCAD interface 

● AutoCAD defaults and drawing units 

● Dealing with file-oriented commands 

● Undo and Redo commands 
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                2.1 STARTING AUTOCAD 

  
      AutoCAD was released in 1982 by Autodesk, Inc., which was a small company at that time. It 

was designed to be used for PCs only. Since then AutoCAD has enjoyed the biggest user base in the 

world in the CAD business. Users can use AutoCAD for both 2D and 3D drafting and designing. 

AutoCAD can be used for architectural, structural, mechanical, electrical, environmental, and 

manufacturing drawings and for road and highway designs. Though the focus these days is BIM 

(Building Information Modeling), 

AutoCAD is still the most profitable software for Autodesk, Inc. due to its ease of use and 

comprehensiveness, which address all user needs. Another version of AutoCAD, called AutoCAD 

LT, is used for 2D drafting only. To start AutoCAD 2019, double-click the shortcut on your desktop 

that was created in the installation process. AutoCAD will show the Welcome window, which looks 

like the following: 
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While you are in this part you can: 
 

 Start a new drawing 

 Open an existing file 

 Open a Sheet Set 

 Download more templates accessed online 

 Explore the sample files that come with the Software 

 See the recent files you opened 

 Check if AutoCAD has a notification for you concerning your 

software/ hardware 

 Connect to Autodesk 360 (Autodesk Cloud) 

 Send your feedback to Autodesk 

 
 

 

 

     Starting a new file or opening an existing file will show you the interface of AutoCAD   2019, which 

will look like the following: 
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2.2 AUTOCAD 2019 INTERFACE 

 

The AutoCAD interface is based on Ribbons and Application Menu. The most important feature 

of this interface is that the size of the Graphical Area will be bigger. 

2.2.1 Application Menu 

The Application menu contains file-related commands: 

 

 

 

 

 

 

 

 

 

 

 

1. Application Menu 2. Start tab 3. File tab 

4. Ribbon 5. Current File Name 6. Info Center 

7. Autodesk 360 8. View Cube 9. Navigation Bar 

10. Cross Hairs 11. Workspace 12. Status Bar 

13. Command Window 14. Layout tab 15. Model tab 

16. UCS Icon 17. Graphical Area  
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Included are commands such as creating a new file, opening an existing file, saving the current 

file, saving the current file under a new name and in a different folder, exporting the current file 

to a different file format, print- ing and publishing the current file, etc. We will discuss almost 

all of these commands in different places in this book. By default, you will see the recent files. You 

can choose how to display the recent files in the Application Menu using this control:  

 

 

 

 

 

 

 

 

Also, you can choose how to sort the recent files using this control: 

 

 

 

 

 

 

 

 

2.2.2 Quick Access Toolbar 

This toolbar contains all File commands mentioned in the Application Menu along with Workspace and 

Undo/Redo. 
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The user can customize this toolbar by clicking the arrow at the end, which will bring up the following: 

 

  

 

 

 

 

 

 

As you can see, the user can add or remove commands; clicking Show Menu Bar may also be useful 

because the ribbon doesn’t include all Auto- CAD commands. 

 

 

2.2.3 Ribbons 

Ribbons consist of two parts: tabs and panels, as shown below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

Some panels have more buttons than shown: the following is the Modify panel: 
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Click the small triangle near the title and you will get the following: 

 

 

 

 

 

 

 

 

 

 

If you move away from the panel, buttons will disappear. To make them visible always, click the 

push pin. The new view will be as follows: 
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     For  some  commands,  there  are  many options.  To  make  the  user’s  life  easier,  AutoCAD put  all  

the  options  in  the  same  button.  Check  the  following  illustration:  

 

 

 

 

 

 

 

 

The ribbons have a very simple help feature. If you hover the mouse over a button, a small help 

screen comes up. 

 

 

 

 

 

 

 

 

 

If the user leaves the mouse over the button for a longer period of time, AutoCAD will show 

more detailed help: 
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 Panels have two states—either docked or floating. By default, all panels are docked in their 

respective tab. Drag and drop the panel in the graphical area to make it floating. One important 

feature of making the panel floating is you will be able to see it while other tabs are active. 

You can send the panel back to its respective tab by clicking the small button at the top right side: 

 

 

 

 

 

 

  

While the panel is floating you can toggle the orientation: 

 

 

 

 

 

 

 

 

It will either extend to the right: 
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The button at the end of the tab names allows you to cycle through the different states of the 

ribbons. The main objective of this new feature is to give you yet more graphical area. Clicking the 

small button will bring up the following: 

 

 

 

 

 

 

 

 

 

 

2.2.4 Info Center 

Info Center is the place to access help topics online and offline, along with some other tools: 

 

For instance, if you type a word or phrase in the field shown below, AutoCAD opens the Autodesk 

Exchange window and finds all the related topics online and offline. Online means all Autodesk web 

sites along with some popular blogs. 

Use Sign In to access Autodesk Online Services. The X at the right will activate the Autodesk Exchange 

Apps web site. 

 

 

2.2.5 Command Window 

       By default, the command window is floating, but you can dock it at the bottom or the top of the 

screen. Reading the command window all the time will save lots of wasted time trying to  
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figure out what AutoCAD wants. AutoCAD will show two things at the command window: your 

commands and AutoCAD prompts asking you to perform a particular action (e.g., specify a point, 

input an angle, etc.). Check the following illustration: 

 

 

 

2.2.6 Graphical Area 

     The graphical area is your drafting area. This is where you will draw all your lines, arcs, and 

circles. It is a precise environment with an XYZ space for 3D and an XY plane for 2D. You can 

monitor coordinates in the left part of the status bar. 

2.2.7 Status Bar 
 

     The status bar in AutoCAD contains coordinates along with important functions; some of 

them are for precise drafting in 2D, and some of them are for 3D. 

 

 

 

 

 

The buttons you will see on the status bar are not necessarily all that are available. To customize 

this, click on the last button at the right (the one with three horizontal lines) and you will see the 

following list (showing some of the options): 
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2.2.8 Start Tab 

     When you click the Start tab at any moment, you will get the welcome screen again. Hence you can 

start a new drawing, open an existing drawing, etc. 

 

2.3 AUTOCAD DEFAULTS 
 

Before using the AutoCAD environment, you should be aware of the following AutoCAD 

settings: 

 AutoCAD saves points as Cartesian coordinates (X,Y) whether metric or imperial 

numbers were used. This is the first method of precise input in AutoCAD to type the 

coordinates using the keyboard 

 

 To specify angles in AutoCAD, assume east (to your right) is your 0o and then go 

counterclockwise. (This is applicable only for the northern hemisphere; we will learn in 

Chapter 10 how we can change this setting for the southern hemisphere) 

 

 

 

 

 

 

The wheel in the mouse has four zooming functions: Zoom In (move wheel forward), Zoom 

Out (move wheel backward), Panning (press and hold the wheel), and Zooming Extents (double-

click the wheel) 

 Pressing [Enter] or [Spacebar] is equal in AutoCAD 

 When pressing [Enter] without typing any command, AutoCAD will repeat the last 

command. If it is the first thing you do in the current ses- sion, it will start Help 

 Pressing [Esc] will cancel the current command 
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

 

Pressing

 

[F2]

 

will

 

show

 

the

 

Text

 

Window—check

 

the

 

following:

 

 

 

 

 

 

 

 

 

 

 

 

 

2.4 What Is My Drawing Unit? 
 

         If you draw a 6-units line in AutoCAD, what does AutoCAD really mean by 6 units? Is it 6 

m, 6 ft, or neither? AutoCAD deals with whatever units you choose; if you mean 6 m, so let it be! 

If you mean 6 ft, AutoCAD will go with this assumption as well. What is important is that you be 

consistent throughout your file. This is true for the Model Space, where you will do your drafting, 

but when it comes to printing, you have to recall your assumption and set your drawing scale 

accordingly. In Chapter 9, we will discuss printing. At the bottom left of the screen you can see the 

model tab and the layouts, just like the following:  
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2.5 Create A New AutoCAD Drawing 
 

    This command will create a new drawing based on a premade template. Use the Quick Access 

Toolbar and click the New button: 

 

 

 

 

 

 

Or you can click the (+) sign in the File tab: 

 

You will see the following dialog box: 

 

Do the following steps: 

 Select the desired template file (AutoCAD template files have the exten- sion .dwt). 

AutoCAD 2019 comes with lots of premade templates that you can use (it is preferable 

for the companies to create their own tem- plate files). 

 Once you are done, click the Open button 

 AutoCAD drawing files have a file extension of .dwg 

 AutoCAD will start with a new file (which has a temporary name like Drawing1.dwg; 

you should rename it to something meaningful) 
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 NOTE 

In the Start tab under the Start Drawing section, you can use the Template drop-down list to choose 

from the existing templates to start a new file, just like the following: 

 

 

 

 

 

 

 

 

 

 

 

2.6 OPEN AN EXISTING AUTOCAD DRAWING 

 
      This command will open an existing drawing file for additional modifications. From the 

Quick Access Toolbar, click the Open button: 

 
 

 

 

 

 

 

 

 

 

 You will see the following dialog box:  
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Take the following steps: 

 Specify your desired drive and folder 

 You can open a single file by selecting its name from the list and click- ing the Open button, 

or you can double-click on the file’s name. Or, you can open more than one file by selecting 

the first file name, holding the [Ctrl] key, clicking the other file names in the list (which is 

a common MS Windows skill), and then clicking the Open button. 

 

2.2.9 File Tab 

Using the File tab beneath the ribbon, you will see a tab for each opened file, as in the following: 

 

 

 The color used is gray. The current file (tab) will appear in a lighter gray, and the other 

tabs will appear in a darker gray. If you hover over one of the tabs, two things will take place: 

 The path of this file will appear above the tab 

 The model space and the layouts of this file will appear beneath 

Check the following:  
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There will be a blue frame around the model space view. Moving your mouse to the right will show 

the layouts in the graphical area; if you find what you are looking for, click the layout view to move to 

it. 

 

 NOTE 

  A star beside the name of the file in the file tab means this file was modified and you need 

to save changes 
 Click (x) beside the name to close the file, hence closing the tab 
 The user can customize the File tabs and the Layout tabs by switch- ing them off; all you 

have to do is to go to the View tab and locate the Interface panel; the two buttons will be 

blue if the tabs are on, but if you want to turn them off, click once on each button 

 

 

 

 

2.7 CLOSING DRAWING FILES 
 

   This command will close the current opened files or all opened files, depending on the 

command you choose. Use the Application Menu, move your mouse to the Close button, 

then select either Current Drawing to close the current file, or All Drawings to close all the 

opened files in single command 
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If any of the open files were modified, AutoCAD will ask if you want to save or close without 

saving, as in the following dialog box: 
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2.8 UNDO AND REDO COMMANDS 

 

  Undo and Redo are to help you to correct mistakes. They can be used in the current session 

only. 

 

 

 

2.8.1 Undo Command 

This command will undo the effects of the last command. You can reach this command by going 

to the Quick Access toolbar and clicking the Undo button. If you want to undo several 

commands, click the small arrow at the right. You will see a list of the commands; select the 

group and undo them: 

 
 

Also, you can type u at the command window (don’t type undo, because it has a different 

meaning), or press Ctrl + Z at the keyboard. 

 

2.8.2 Redo Command 

This command will undo the undo command. You can reach this command by going to the Quick 

Access toolbar and clicking the Redo button. If you want to redo several commands, click the small arrow 

at the right. You will see a list of the commands; select the group and redo them: 

 

 
 

 Also, you can type redo at the command window or press Ctrl + Y. 



  

 

21 LECTURE 2                                 AutoCAD 

 Lecture. Abdullah Thaier Abdalsatir 
 Eng. Sabreen abdellmajeed  

 Department of Computer Engineering 
first stage: drawing by using computer         

   

    r  

PRACTICE   LECTURE 2 

 

1-Start AutoCAD 2019 

2-Open the following files  
 

a) Ground Floor 
 

b) Mechanical-1 
 

c) Mechanical-2 
 

3-Using the File tab, check the three files and their layouts 

 

4-Use the different zoom techniques with the mouse wheel 

 

5-Using the Application menu, close all files without saving 




